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Welcome to sforzando

Back in 2005 when Gary Garritan gave me the task to design a complex sample playback engine, I obviously started with 
some homework. First question was obviously: “Is there already an instrument format that is open, powerful, flexible enough, 
and future proof”? YES! And its called SFZ!. Not only that, but I also found out it was invented bysomeone I both admired and
respected, my old #musicdsp IRC buddy René Ceballos. The more I looked into it the more it was also obviously that René 
did his homework as well, since he made sure his SFZ 1.0 specification pretty
much covered everything from SF2/DLS/GIG and other formats of the day.

His first implementation of the format was in the famous sfz.dll plugin, originally given for free on rgcaudio.com.
After being acquired by Cakewalk - and for a good while later-, René pursued the development of his specification, this
time with some help from Chad Beckwith, culminating with the SFZ 2.0 format as implemented in Cakewalk Dimension(tm) in
2005 and in Drop Zone(tm) a few years later.

Meanwhile at Plogue, we were just getting ready to ship the first product based on our new ARIA Engine: the Garritan
Authorized Steinway Model D. Entirely SFZ based, this multi gigabyte sampled piano already utilized a few new SFZ
opcodes that were submitted to René for review. Some of these were officially added to the specification, while others
were still pending at the time René and Chad left Cakewalk. Simon Cann's Cakewalk Synthesizers: from Presets to
Power User 2nd Edition however lists some of these new opcodes.

Fours years have passed, and we pursued designing new opcodes (the so called 'ARIA-extensions'), mostly to keep the
specification up to date with what other - newer - contemporary sample formats offered. Each time we did this, we asked
ourselves: “What would René do?” How would HE transform a specific feature request into one or a series of opcodes
in such a way that would both makes sense, and wouldn't break existing compatibility. This is not a trivial task for only
one implementation. We hope to disclose as much info as possible on our extensions with the new forum and wiki on
ariaengine.com, but time and resources are limited.

But one GIANT problem persisted until today. There were no 'free as in beer' ARIA-based products allowing SFZ editing and 
importing. This is why we now present you Plogue sforzando, the new free, minimalistic SFZ 2.x player!

Plogue sforzando, has only ONE instrument slot, no mixer. Just the ability to load SFZ files and to play
sounds from current ARIA-based products. Of course we understand that editing text files to create sounds is not for
everyone, but we've had too many requests for a product such as this not to pursue René's tradition of giving away a
simple player.

David Viens, December 2012



What is sforzando?

sforzando is a free (as in beer) minimalistic SFZ 1.0 and 2.x player.

sforzando integrates our uniquely powerful and high-performance software synthesizer/sampler engine ARIA.

sforzando can work as a standalone application or as a plug-in for most major sequencing audio programs. 

Features of sforzando
 Easy-to-Use – Just load SFZ files and play!
 Universal Format - Supports all popular formats, Mac and PC, as a standalone program or as a plug-in (VST,

AAX, and OS X AU), and works with supported sequencers. 

What’s Included

This  version of sforzando includes the following:
 Download file containing the complete sforzando software.

Before you begin installation, make sure you have read the End User Licensing Agreement in the pages which follow. 
By installing the software you are indicating you agree to the terms of the license.

Further Documentation and Resources

For the latest information including updated documentation, visit our support pages at: 
www.plogue.com. There you can find: Updated information provided after the manual was written Corrections or addi-
tions to this manual FAQ pages answering common questions suggestions from the users of Plogue software and news
about upcoming Plogue releases. You can also visit the Plogue Forums for up-to-date information. 

The address is: www.plogue.com/phpBB  3  / . 

http://www.plogue.com/phpBB2/
http://www.plogue.com/phpBB2/
http://www.plogue.com/phpBB2/


Specifications & Computer System Requirements 

The following table lists the computer and hardware requirements for using sforzando. You can use sforzando on most 
any modern personal computer that meets the specifications listed below. The specifications provide the minimum stan-
dards. For optimal functioning, it is recommended you have a powerful enough computer with a fast CPU processor, and 
a large amount of RAM. The ARIA audio engine is designed to make use of the processing power of your computer’s 
CPU. The powerful and complex algorithms of the ARIA Engine work best on modern CPU's. We think that’s a small 
price to pay for the results you will get. Please also observe the systems requirements of your host application, tracker 
program and/or sequencing program if applicable. Please see the Plogue forum or website if you are looking for recom-
mendations or for more information.

Computer System Requirements
Computer Operating System Hardware
Windows PC 32/64bit:

Microsoft Windows Vista
Microsoft Windows 7
Microsoft Windows 8
Microsoft Windows 10

2.4 GHz CPU Pentium 4 or better, 2.0 GHz Core  Duo or better 
recommended
1 GB Minimum, 2 GB RAM recommended if used with other instruments 
at the same time.
15 MB of free hard drive space
Monitor with 1,024x768 resolution or better for usage of the default skin.
A sound card compatible with ASIO, DirectSound, or MME
Keyboard: A MIDI interface may be required if you are using a MIDI key-
board. Some keyboards use USB.  
High quality speakers and amplifier, or high quality headphones
Internet connection for download, updates.

Mac Mac OSX 10.6.8 minimum Mac Intel;  Core Duo or better recommended
1 GB Minimum, 2 GB RAM recommended if used with other instruments 
at the same time.
15 MB of free hard drive space
Monitor with 1,024x768 resolution or better for usage of the default skin.
A MIDI interface may be required if you are using a MIDI keyboard. Some 
keyboards use USB. 
High quality speakers and amplifier, or high quality headphones
Internet connection for download, updates and online registration

The stated requirements represent minimum guidelines for the Standalone sforzando Player. If you are using sforzando 
within a host music program, then there may be other additional resource requirements. Please also observe the system 
requirements of your host application, tracker program and/or sequencing program if applicable. The demands of various
other processing software (including the sequencer, audio and effects processors, other plug-ins, and so on) can affect 
functionality.



Regarding Sound Cards & Midi Interfaces

The quality of the audio interface will have a significant effect on the quality of the sound you will hear from sforzando. It
will also have a substantial effect on performance (latency). Therefore, a good sound card is one of the most important
components in optimizing the sound and performance of sforzando.

In theory, any audio or sound interface which your OS and computer supports should work. However, you are unlikely to 
get the best sonic results from a sound card designed for computer games or system sounds. Most computers come with
a consumer-grade sound card, and we recommend that you get a good quality sound interface beyond that which is built 
into your computer. Older SoundBlaster sound cards (which do not support multiple sample rates) and gamer-oriented or
home system sound cards may be problematic. It is not possible for us to test all built-in or third-party sound cards, and 
some interfaces do have problems on some platforms.

Technical Info

A low latency audio interface with ASIO 2.0 (Windows), or Core Audio (Mac), drivers is required for sforzando to work as 
a stand-alone program. These drivers are normally installed with the audio interface, or the most recent versions can be 
acquired from the manufacturer’s website. Contact the manufacturer of your interface for more information. The drivers 
should be set to 24 bit, buffer size 256 samples (optimal) or 512 (more latency, but less CPU load) and 44100Hz Sam-
pling Rate.

Please note:                                                                                                                                       
When sforzando is running as a plug-in, it uses the audio driver selected by the host’s setup. If the host (typically your
sequencer program) is set up properly and works well, then the sforzando plug-in should pass through the same au-
dio and MIDI setup. For this information, please refer to your sequencer, tracker program or host’s manual. 

                                                                                                                                                                                                              

Similarly, any MIDI interface the manufacturer supports for your system should work with sforzando.



INSTALLATION



Installing sforzando

Installing sforzando is easy. Before you begin, make sure you meet the system requirements The full installation requires
approximately one hundred megabytes of free hard disk space. Installation involves installing the sforzando instruments 
and also the advanced ARIA engine. A setup program will guide you through the process step-by-step.

Mac Setup

 First, make sure your audio and MIDI hardware is set up and working with your computer.
 Close any programs you are running.
 Once downloaded, the Archive Utility  will unpack this to your default downloads directory.
 Double click on MAC_sforzando_V x.xxx.pkg 

 You will then be asked to accept the End User License Agreement before proceeding with installation.



 The setup lets you select which plug-in formats you require. These plug-in formats allow
sforzando, in addition to standalone use, to run as a virtual instrument plug-in that seamlessly integrates into your 
favorite music software program or sequencer (assuming that it accepts such instrument plug-ins). Please refer to
the chapter “Using sforzando as an Instrument Plug-In” for further information. 

For Mac, the Choices are Audio Units, RTAS (32bit), AAX (64bit) and VST at least ONE needs to be chosen. 
Tablewarp2 is a free sforzando synth included as a bonus.

 Setup is now ready to begin installing sforzando. Click on “Install” to begin installation and the program will begin 
installing. This process should not take more than a minute.

 After a few moments a dialog box will notify you that the setup wizard has finished installing sforzando on your 
computer.



When  installation is complete, you should see the sforzando app in your Applications folder:

You can drag the “sforzando” icon onto your Dock. 

I  mportant:                                                                                                                                                                     
Please do not cancel setup after installation begins, otherwise a partial, broken installation may re-
sult.
                                                                                                                                                                                    



Windows Setup:
It is recommended that you just select “Next” for each screen and use the defaults.  

 First make sure your audio and MIDI hardware is set up and working with your computer.
 Close any programs you are running.
 After download, unzip by double-clicking WIN_sforzando_vx.xxx.exe.
 You will then be asked to read and accept the End User License Agreement before proceeding with installation

and choose the destination folder. Defaults are fine since no samples are streamed while using this virtual instru-
ment. (the full size is close to 15MB.)

 The setup lets you select which plug-in formats you require. These plug-in formats allow sforzando, in addition to 
standalone use, to run as a virtual instrument plug-in that seamlessly integrates into your favorite music software 
program or sequencer (assuming that it accepts such instrument plug-ins). Please refer to the chapter “Using 
sforzando as an Instrument Plug-In” for further information. For Windows the choices are VST, RTAS(32bit) and 
AAX(64bit)



 If you select to install the VST32 and VST64 versions of sforzando, you will also be prompted with your preferred 
VST plugins folder in each case:

♦ Where you want to put sforzando's shortcuts and icons should be placed. For most instances, use the default.



 Setup is now ready to begin installing sforzando. Click on “Install” to begin installation and the program will begin 
installing                                     

   You will see a final screen indicated that the full installation is complete.

Important:                                                                                                                                           
Please do not cancel setup after installation begins, otherwise a partial, broken installation 
may result.
                                                                                                                                                              
Updating to the Latest Version

Be sure to check the Plogue Web sites for any possible updates that have occurred since the time your version of the 
software was released. Software is frequently updated and a more recent version may be available.



How to Use sforzando

Once installed  it’s time to get started with sforzando. 
There are three ways to use sforzando: as a plug-in within a sequencer, with a supported tracker program, or you can 
play it ‘live’ as a standalone application.

Playing sforzando as a Standalone Application (‘Live’ Play)

sforzando can be launched by itself and played live via MIDI keyboard or other MIDI controller. The standalone version of
sforzando effectively makes your computer, audio hardware and MIDI keyboard into a virtual synthesizer that can be 
played independently of other programs.  Unlike using it as a plug-in within a sequencer, your recording ability is limited 
and you can not edit your performance (though you can use various audio software programs for this).

Launching sforzando in Standalone Mode

First, make sure that you have followed the instructions in the installation section of this manual. Be certain that your au-
dio/sound interface and MIDI hardware interfaces are properly connected to the computer, your speakers or headphones
are connected and everything is powered up.

To launch sforzando as a standalone application, click on the sforzando logo on your desktop or go to the Program Files 
or Applications folder and launch “sforzando”.

Basic Setup Information for Standalone Mode

To use the standalone version you have to configure the Audio and MIDI settings in the Preferences dialog box (found in 
the Tools menu) before you can play. When used as a plug-in, the host sequencer or tracker program has already set up 
its audio and MIDI connections, and the sforzando “plugs in” to them. However, with standalone operation sforzando 
communicates directly with your audio and MIDI interface. Setup for Mac and Windows computers is similar, except 
where indicated. Note that if you change your audio interface, you will almost certainly need to readjust these settings.

Call up the Preferences setup dialog from the Tools menu on the Plogue Aria standalone interface. You’ll see drop-down 
menus for MIDI Device, Audio Devices, Stereo Pair, Sample Rate and Buffer Size.



 MIDI Device Menu: All supported (and installed) MIDI interfaces are available in this drop-down list. Select 
the desired MIDI device from the list. The Plogue Aria Engine sends and receives MIDI on these selected devices.

 Audio Device Menu: All supported (and installed) audio interfaces are available in this drop-down list. 
Select the desired audio device from the list.

 Stereo Pair: Here you can define which of the stereo outputs should be used. Many pro audio devices have a 
variety of outputs, so you may choose which of these are available on your system that you would like sforzando to
output through.

 Sample Rate: Depending on the sound card and driver you are using, various sample rates are available. Set
the desired sample rate here. 

 Buffer Size: The buffer size setting will determine the delay between pressing a key on your MIDI keyboard 
and hearing the sound (a/k/a ‘latency’). The default buffer size of 512 samples typically works well, but smaller 
buffer sizes will give a faster response (lower latency) and higher buffer sizes will give better audio performance 
(more polyphony and higher fidelity). Most modern computers and audio interfaces can handle a buffer size of 
512 samples without a significant reduction in polyphony. If the sound is breaking up or crackling when a note 
sounds, then first check that the audio connections and wiring are good. Then, try a larger audio buffer size 
setting. Please note that there is typically a trade-off between higher buffer sizes (polyphony and sound fidelity) 
and lower buffer sizes (faster response or lower latency). Also note that the sound card buffer size settings 
determine latency, rather than sforzando Player itself. 

Once you have your Audio and MIDI set up, and have loaded one of the snapshots, you can begin playing sforzando. 
Press (use your mouse to click on) a key on the on-screen piano keyboard on the sforzando  Player interface. If you can 
hear the chips play, try playing a key on your MIDI keyboard. If the MIDI and audio configurations are correct, you should 
hear the corresponding synth note. If not, check the MIDI connections and wiring, and the MIDI output channel of your 
MIDI keyboard. Also check that the channel is specified correctly. If you are hearing the notes play, then the basic config-
uration is complete, and you are ready to use sforzando.

File Menu for Loading and Saving Snapshots in the Standalone

Configuration presets (.aria files - binary) for sforzando can be saved and loaded.  This gives the user the 
ability to customize instruments setups to suit personal preferences and save configurations for convenient 
future use. The File menu choices are:

 Load—any saved configuration preset files in Aria format can be loaded by clicking 
on this choice and selecting the desired file.

 Save—any configuration can be saved by clicking on this choice, typing a name for 
the custom preset and saving to a desired location.

 Save as default—any settings can be saved as part of the default, to be loaded 
automatically at the time the sforzando player is booted in standalone mode.

Tools Menu in Standalone ONLY 

The Tools menu includes:
 Preferences—as described in the basic setup information above.
 Render offline—MIDI files can be rendered to audio offline using this feature.



To use the Render Offline feature:

1. Click on the Load MIDI file button.
2. Select the desired MIDI file
3. Click on the Name audio file button.
4. Name the audio file and specify its location.

Once the files are in place, there is just one more step:

Click on the Render button. The audio file will be rendered to the specified location.



MIDI File Player and Audio Recorder (Standalone Version Only)

The standalone version of the player includes a MIDI file player and Audio Recorder. It is located at the bottom of the 
standalone window. This feature enables the user to load and play a standard MIDI file and render an audio file from it. 
The MIDI controls are located on the left hand side and the audio controls on the right.

To load and play a MIDI file:
1. Click on the “Load” button.
2. Choose the file you wish to load.
3. Click on the “Play” button.

The MIDI file will play back using the presently loaded chip setup and any other features (e.g. Ambience reverb) activat-
ed in the player. The progress bar will move to the right as the file is played. To start the file from the beginning, click on 
the “Go to beginning” button. The file can be stopped at any time by clicking on the “Stop” button.

To record your playback to an audio file:

1. Click on the “Name file” button.
2. Name the file and specify its desired location.
3. Click on the “Record” button.
4. Start playback by clicking on the MIDI “Play” button.
5. When playback finishes, click on the MIDI “Stop” button.
6. Click on the Audio “Stop” button.

The audio file will be located on your drive in the location you specified.

Note:                                                                                                                                                    
There is also an offline rendering feature (explained previously) that is located in the “Tools” menu of the standalone ver-
sion.



Using sforzando as an Instrument Plug-In

When used as a plug-in, sforzando is not a standalone program but rather a virtual instrument module that is seamlessly 
integrated into your favorite music software program or sequencer (assuming that it accepts such instrument plug-ins). 
They are called “plug-ins” because these are modular software applications that run inside a “host” music application, 
(e.g. a sequencer or tracker program, typically).

There are various uses as a plug-in:

 MIDI recording and sequencing of sforzando. 
 Audio mixing of sforzando with other instrument tracks within a single program
 Easy automation of sforzando parameters in the music software program through the use of MIDI CC's, which 

gives you the possibility of automating all 8 slots. Or using your host's “parameter automation”, which allows you 
to automate the first slot only.

 Effect processing of sforzando using effect plug-ins in a music software program Saving and recalling of all plug-in
settings when the music software program or sequencer file is reloaded

 Integration with other instruments into a “virtual studio”

A great thing about plug-ins is that they work with a large variety of compatible music programs. For example, sforzando 
can be used as a VST plug-in in many VST music programs, sequencers, supported tracker programs and hosts. 
sforzando can also be used as an Audio Units plug-in or as an RTAS plug-in.

VST The VST plug-in stands for Virtual Studio Technology and was 
developed by Steinberg, the makers of the Cubase family of au-
dio programs. It is also used by Cakewalk Sonar, Ableton Live, 
Renoise, Bidule, FL Studio and other sequencers.

X X

Audio Units The Audio Units (AU) plug-in standard was developed by Apple 
Inc. for Core Audio under Mac OS X. Audio Units is the pre-
ferred plug-in format on Mac OS X and is used by Apple 
GarageBand & Logic and MOTU Digital Performer.

X

RTAS RTAS plug-ins (Real Time Audio Suite) are designed to work in 
the Digidesign Pro Tools (10 and previous) environment. Pro 
Tools hardware and software are used extensively in the pro au-
dio and post production communities.

X X

AAX (64 bit) AAX plug-ins (Avid Audio eXtension) are designed to work in 
Avid Pro Tools 10 (and later) environment. Pro Tools hardware 
and software are used extensively in the pro audio and post pro-
duction communities.

X X

Basic Setup Information for Using sforzando as a Plug-In Instrument

To use sforzando as a plug-in instrument, you simply launch your host music application/sequencer first and then launch 
sforzando from within it. Make sure that your sequencing host program is properly installed and configured, and that it is 
producing sound properly. Used as a plug-in, sforzando’s audio and MIDI data is managed by the host music software 
application.

Using sforzando in a Specific Music Program or Sequencer

sforzando works as a plug-in instrument within many popular music software programs. Each music software application 
has its own approach to handling plug-in instruments. They each have a different method of installation as well as differ-



ing means of loading and accessing plug-ins. It is important to make sure that you refer to the instructions in your music 
software application’s manual regarding the loading and operation of plug-in instruments.

Saving sforzando Parameters in a Music Program or Sequencer

While using sforzando with a host music application, when you save a sequence or project with the host program, you 
will save all of sforzando’ parameters as well (As long as sforzando is properly registered with the current user). The pa-
rameter saving will occur automatically when you save the file in your music application and you don't need to do any-
thing in the sforzando Player interface for this to happen. When you re-load your host music project, sforzando settings 
will revert to the state in which they were when you saved your project file.

Important Technical Notes:                                                                                                            

Windows VST applications only: To use sforzando with more than one VST application, you need to manually copy 
the “sforzando VST_x86.dll” file, installed into the chosen folder during installation of the software, to the appropri-
ate VST-compatible host application’s VST folder. Please refer to your particular application’s user’s guide and the 
Plogue support site for more information.

Regarding 64-bit hosts: Some hosts have one common VST folder for both x64 and 32-bit plug-ins, please only 
use the version of the plug-in that is native to your host, e.g.: x64 bit version of Sonar, use the sforzando VST_x64.dll.
Mac OS X has standard folders for both VST and AU plug-ins and do not require this extra step.

                                                                                                                                                          

An additional copy of the VST plug-in is available in the main sforzando applications folder, in the VST sub-folder. Please 
don’t use this folder as your main “vstplugins” folder. Please note that a saved sequence in one music application may 
not be usable in other music applications, as each application generally has its own proprietary format. However if you 
can export and import standard MIDI files between two programs, then combined with .aria(x) files it can serve as a 
means to exchange tracks between them.

How sforzando Works- The Info tab 



The Basic Interface and the View Screens

The Aria Engine is a custom-made Virtual Instrument Engine developed specifically for Plogue and Garritan sound li-
braries and synthesizers, such as sforzando. It constitutes the best sounding and most powerful sample/synthesis engine
available, built from the ground up for high performance and exceptional quality. The Aria Player enables you to load 
sforzando instrument sounds, control various parameters for playback, and do a number of other things. The software 
engine was custom designed and programmed by Plogue Art et Technologie Inc.  The Aria Player has various view 
screens or “windows” that are accessed by the five view tabs across the bottom right. Those screens consist of the “Mix-
er” window, the “Controls” window, the “modulation”, “Effects”  and the “Settings” window.

A. Load Program: Click here to load a program.
Clicking the File slot brings up a dialog box from which you can load the program of your choosing. The instruments will
be grouped in a simple hierarchical menu for each ARIA-based Library you have installed (if you have any).
The instruments are also placed in sub groups: “01 - Brass” , “02 – Woodwinds” etc.

Choosing “Empty” will remove an assigned instrument from a channel and wipe all previous controller data received.
Choosing “Import” will allow you to load any standard SFZ 1.0 and SFZ 2.0 file, or import any of the supported formats
(subject to change) Dropping an SFZ file on the interface will do the same thing.

Choosing “Reload” will restore the default parameter settings for that instrument.

B. Key Switch: Keyswitches are certain reserved keys (usually the lowest octave on the keyboard) that are used to 
rapidly
change from one type of articulation to the other without requiring loading a new sound. You can also change
the current waveform (or KS) in the controls tab chip section, or using MIDI Program Changes.
Key switching (or “KS”) is used to manually change waveforms by only using the keys. (It's a technique used
by old organs, and more recently by many large sample libraries – including the whole Garritan offering, and it's
not the typical thing you find on software synthesizers.
Key switching provides some great advantage for MIDI automation in your sequencer, and for automation



through the built in wave sequencer module. As it doesn't reload anything, it”s instantaneous and causes no
CPU hit.

C. Volume Control Knob (CC7)
This knob controls the relative volume level of the instrument. If the SFZ file loaded does not natively support
CC7, then the engine is going to provide a standard GM handler for it.

D. Pan Knob (CC10)
This knob controls the left to right position of the instrument in the stereo field. If the SFZ file loaded does not
natively support CC10, then the engine is going to provide a standard GM handler for it.

E. Effect Send Knob (CC91)
This knob controls the amount of sound sent to the internal effects (Ambience reverb or Detune Chorus.

F. Transpose / Tuning Settings
Click/drag the numbers to change tuning from -12 to +12 semi tones, and -100 to +100 cents. This is very
useful to thicken an instrument used as a layer in a more complex sound. You can CTRL-click (Command-Click
on OSX) on the numbers to bring back to its default position

G.  Polyphony Setting
Click the number to change the polyphony.
The 32 voice default value is often enough for full chords/ sostenuto pedal passages.

H. Pitch bend range
Adjusts the range of the pitch bend in semitones

I. Snapshot Menu
This is where you access presets delivered with most instrument banks for sforzando. You can also save/recall your own 
master presets using the drop-down menu.

J. SFZ details and edit feature
Once an sfz file (one which is not part of an official ARIA library) is loaded, you will have access to it's main
programming characteristics: how many <curve>, <control>, <global>, <master>, <group> and <region>
sections are contained in the sfz.
If your global, master, group and region sections are labeled, you will see the name of the last one triggered,
helping you editing and fixing your sfz.

K. Keyboard
The bottom of the window features a virtual on screen keyboard that indicates the range of notes that can be
played on that instrument setting. Keys that are being played will be shown in real time.

L. Piano pedals
Graphical representation of the three pedals on a piano. These send and respond to the standard MIDI CCs
associated with standard pedal controllers : cc67 (left pedal, una corda), cc66 (center pedal, sostenuto) and
cc64 (right pedal, sustain)

Controls Tab : 

KEYSWITCH TIPS
 Always put the keyswitching note for the particular instrument *before* the first note of the articulation you 

want to play, not on the same time!

 Remember that when you hit "play" on the sequencer, ARIA  will remember the last keyswitch used.

 If you transpose your score, you must be sure NOT to transpose the KS notes!! Any transposition to these 
notes will change (or eliminate) their function.



If MIDI CCs are assigned in your sfz files, A “DragLabel” will be created for it in the Controls tab. All Drag Labels (virtual 
knobs) in the Controls Window can be adjusted by holding down the left button of your mouse and moving it up /down or 
left/right. Release the button to set the level. The numerical text will give a measurement reading. Patches from ARIA 
libraries will show their own custom controls. 

NEAT ARIASFZ TRICK 

MIDI CCs in a sfz file will be named as paramXX. (X being the cc, or extended cc number) But you can add the opcode 

“label_ccXX= ” in the <control> section of your sfz file that will allow you to name the parameters any way you want in 
the interface. For example in the screenshot below, we added label_cc71=resonance (CC71) 



Settings Tab 

The Settings tab brings up additional information about the current ARIA Engine instance. This is mostly there as an ARIA
engine troubleshooting display. It displays the version of the software and its copyright information as well as information 
about how the ARIA engine is performing. The information in the left-hand column indicates the software’s current RAM 
usage. The middle column contains the software’s current resource pool status. 

You can adjust some of the settings in this window by clicking on certain boxes to reveal a drop-down menu. 

● Max Engine RAM: Determines the threshold for RAM usage by the software. The default is “512 MB.”

● Pre-Caching: Determines how many samples of an instrument the software will process before playing them. A 
higher setting will result in longer initial load times, though you should increase this setting if you are using a 
slower computer. The default is “32 Kb.”

● Tuning: Determines the tuning system of the instrument in the software. There are different tunings for regions 
throughout the world, but to start, we recommend the default, “International 440.”

●  Converted Files Path: Converted SFZ files which were originally in other formats are stored in this specified 
location. Currently SF2, DLS, Acidized wav. (if you have chipsounds, you can also import MODs and other 
formats) (also see Importing Sounds) 

● User Files Path: You should point this to a folder containing your misc sfz files, or downloads, anything that is 
not in an official ARIA sound library. 

● Scala: Selects a specific tuning file.

● Scala center: Select root note for the scale



Skinning:

No UI will ever please everyone. You can create your own skin by modifying the GUI directory. If you can edit HTML 
layouts, and mess with Adobe Photoshop, you will surely have no problems figuring out the ARIA xml GUI tags. 

 In case of severe doubt, please post on the sforzando forums for details.

Importing Sounds: 

sforzando has the ability to import certain sound formats (list subject to change). The files must have a known extension 
for it to be recognized. Different ARIA products can install their own converters. Just click on the selection socket and use
the 'import' menu, or (under some platforms/plugin APIs) just drag a file on the interface: 

First time you will be asked for a destination repository for the conversion/extraction. We suggest using a folder/drive 
where you typically store your samples on. The Aria Engine will then create a “ARIAConverted” sub folder in the specified
location and will store the results of any conversions in there. 

Once a file is successfully converted, not only will it automatically load, but it will also be available in the Converted 
menu next time you start sforzando (Or any other ARIA-based product, like the ARIA Player) as long as the 
ARIAConverted folder is kept intact. This folder is scanned upon start and the Converted menu is dynamically 
reconstructed. 

Getting Help 
The first place to look for a solution to any problem you may be experiencing is in this manual. Please read the manual 
before contacting support. 

Please check the support area of our website at www.plogue.com for the latest up-to-date information products, 
troubleshooting, FAQs, helpful hints and tutorials. Another resource is the support forums. 

Whenever you encounter problems, you should also check if you have installed the latest updates. The version number 
of your software is displayed in the settings tab. Updates are released regularly to fix known problems and to improve 
the software. 

The best way to get the help you need is by giving us plenty of detailed information about the problem you are having. 
We do ask you to read this guide thoroughly and exhaust the other avenues of support before contacting us. 

The sforzando/SFZ forum can be accessed at: www.plogue.com/phpBB3/ You don't have to register to browse posts, but 
before you can post, you will have to sign up. 

http://www.plogue.com/phpBB3/


IMPORTANT NOTE ON PRESETS:

.aria files : full content of the UI is saved, including values of CC's at the time of saving.
(VST hosts fxb/fxp files are similar in that they contain the same data)

You can currently only save .aria files from the STANDALONE application. 
If you use a VST host that support them, you can however save a FXB file.

You can load aria files in the standalone using the file/open menu, or by dragging them on the UI 
(including fxb/fxp files) of any incarnation of sforzando (standalone/VST/AU/RTAS)

.ariax files are just plain text XML versions of the contents of .aria files (easier to manually hack). You can load 
and save those through the “snapshots” menu.
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